8. Cadence PCB Design Tools Support

This chapter addresses how the Quartus® II software interacts with the Cadence Allegro Design Entry HDL software and the Cadence Allegro Design Entry CIS (Component Information System) software (also known as OrCAD Capture CIS) to provide a complete FPGA-to-board integration design workflow.

With today’s large, high-pin-count and high-speed FPGA devices, good PCB design practices are important to ensure the correct operation of your system. The PCB design takes place concurrently with the design and programming of the FPGA. An FPGA or ASIC designer initially creates the signal and pin assignments and the board designer must transfer these assignments to the symbols used in their system circuit schematics and board layout correctly. As the board design progresses, you must perform pin reassignments to optimize the layout. You must communicate pin reassignments to the FPGA designer to ensure the new assignments are processed through the FPGA with updated placement and routing.

This chapter is intended for board design and layout engineers who want to begin the FPGA board integration process while the FPGA is still in the design phase. Part librarians can also benefit from this chapter by learning the method to use output from the Quartus II software to create new library parts and symbols.

This chapter discusses the following topics:

- Cadence tool description, history, and comparison.
- The general design flow between the Quartus II software and the Cadence Allegro Design Entry HDL software and the Cadence Allegro Design Entry CIS software.
- Generating schematic symbols from your FPGA design for use in the Cadence Allegro Design Entry HDL software.
- Updating Design Entry HDL symbols when making signal and pin assignment changes in the Quartus II software.
- Creating schematic symbols in the Cadence Allegro Design Entry CIS software from your FPGA design.
- Updating symbols in the Cadence Allegro Design Entry CIS software when making signal and pin assignment changes in the Quartus II software.
- Using Altera-provided device libraries in the Cadence Allegro Design Entry CIS software.

The procedures in this chapter require the following software:

- The Quartus II software version 5.1 or later
- The Cadence Allegro Design Entry HDL software or the Cadence Allegro Design Entry CIS software version 15.2 or later

© 2012 Altera Corporation. All rights reserved. ALTERA, ARRIA, CYCLONE, HARDCOPY, MAX, MEGACORE, NIOS, QUARTUS and STRATIX words and logos are trademarks of Altera Corporation and registered in the U.S. Patent and Trademark Office and in other countries. All other words and logos identified as trademarks or service marks are the property of their respective holders as described at www.altera.com/common/legal.html. Altera warrants performance of its semiconductor products to current specifications in accordance with Altera’s standard warranty, but reserves the right to make changes to any products and services at any time without notice. Altera assumes no responsibility or liability arising out of the application or use of any information, product, or service described herein except as expressly agreed to in writing by Altera. Altera customers are advised to obtain the latest version of device specifications before relying on any published information and before placing orders for products or services.
The OrCAD Capture software with the optional CIS option version 10.3 or later (optional)

These programs are very similar because the Cadence Allegro Design Entry CIS software is based on the OrCAD Capture software. This chapter refers to the Cadence Allegro Design Entry CIS software; however, any procedural information can also apply to the OrCAD Capture software unless otherwise noted.

For more information about obtaining and licensing the Cadence tools and for product information, support, and training, refer to the Cadence website (www.cadence.com). For more information about the OrCAD Capture software and the CIS option, refer to the Cadence website (www.cadence.com). For more information about Cadence and OrCAD support and training, refer to the EMA Design Automation website (www.ema-eda.com).

Product Comparison

The Cadence and OrCAD design tools are different in their function and location of product information. Table 8–1 lists the Cadence and OrCAD products described in this chapter and provides information about changes, product information, and support.

Table 8–1. Cadence and OrCAD Product Comparison

<table>
<thead>
<tr>
<th>Description</th>
<th>Cadence Allegro Design Entry HDL</th>
<th>Cadence Allegro Design Entry CIS</th>
<th>OrCAD Capture CIS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Former Name</td>
<td>Concept HDL Expert</td>
<td>Capture CIS Studio</td>
<td>—</td>
</tr>
<tr>
<td>History</td>
<td>More commonly known by its former name, Cadence renamed all board design tools in 2004 under the Allegro name. Based directly on OrCAD Capture CIS, the Cadence Allegro Design Entry CIS software is still developed by OrCAD but sold and marketed by Cadence. EMA provides support and training. The basis for Design Entry CIS is still developed by OrCAD for continued use by existing OrCAD customers. EMA provides support and training for all OrCAD products.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor Design Flow</td>
<td>Cadence Allegro 600 series, formerly known as the Expert Series, for high-end, high-speed design.</td>
<td>Cadence Allegro 200 series, formerly known as the Studio Series, for small- to medium-level design.</td>
<td>—</td>
</tr>
</tbody>
</table>
| Information and Support | www.cadence.com  
www.ema-eda.com | www.cadence.com  
www.ema-eda.com | www.cadence.com  
www.ema-eda.com |
FPGA-to-PCB Design Flow

You can create a design flow integrating an Altera FPGA design from the Quartus II software through a circuit schematic in the Cadence Allegro Design Entry HDL software or the Cadence Allegro Design Entry CIS software. Figure 8–1 shows the design flow with the Cadence Allegro Design Entry HDL software. Figure 8–2 shows the design flow with the Cadence Allegro Design Entry CIS software.

Figure 8–1. Design Flow with the Cadence Allegro Design Entry HDL Software
Figure 8–1 and Figure 8–2 show the possible design flows, depending on your tool choice. To create FPGA symbols using the Cadence Allegro PCB Librarian Part Developer tool, you must obtain the Cadence PCB Librarian Expert license. You can update symbols with changes made to the FPGA design using any of these tools.

To integrate an Altera FPGA design starting in the Quartus II software through to a circuit schematic in the Cadence Allegro Design Entry HDL software or the Cadence Allegro Design Entry CIS software, follow these steps:

1. In the Quartus II software, compile your design to generate a Pin-Out File (**.pin**) to transfer the assignments to the Cadence software.

2. If you are using the Cadence Allegro Design Entry HDL software for your schematic design, follow these steps:
   a. Open an existing project or create a new project in the Cadence Allegro Project Manager tool.
   b. Construct a new symbol or update an existing symbol using the Cadence Allegro PCB Librarian Part Developer tool.
   c. With the Cadence Allegro PCB Librarian Part Developer tool, edit your symbol or fracture it into smaller parts (optional).
   d. Instantiate the symbol in your Cadence Allegro Design Entry HDL software schematic and transfer the design to your board layout tool.

   or

   If you are using the Cadence Allegro Design Entry CIS software for your schematic design, follow these steps:
   a. Generate a new part in a new or existing Cadence Allegro Design Entry CIS project, referencing the **.pin** output file from the Quartus II software. You can also update an existing symbol with a new **.pin**.
b. Split the symbol into smaller parts as necessary.

c. Instantiate the symbol in your Cadence Allegro Design Entry CIS schematic and transfer the design to your board layout tool.

Performing Simultaneous Switching Noise (SSN) Analysis of Your FPGA

With the Quartus II software, you can extract pin assignment data and perform SSN analysis of your FPGA design for designs targeting the Stratix III device family. You can analyze SSN in your device early in the board layout stage as part of your overall pin planning process; however, you do not have to perform SSN analysis to generate pin assignment data from the Quartus II software. You can use the SSN Analyzer tool to optimize the pin assignments for better SSN performance of your device.

For more information about the SSN Analyzer, refer to About the SSN Analyzer in Quartus II Help and the Simultaneous Switching Noise (SSN) Analysis and Optimizations chapter in volume 2 of the Quartus II Handbook.

Setting Up the Quartus II Software

You can transfer pin and signal assignments from the Quartus II software to the Cadence design tools by generating the Quartus II project .pin. The .pin is an output file generated by the Quartus II Fitter containing pin assignment information. You can use the Quartus II Pin Planner to set and change the assignments in the .pin and then transfer the assignments to the Cadence design tools. You cannot, however, import pin assignment changes from the Cadence design tools into the Quartus II software with the .pin.

The .pin lists all used and unused pins on your selected Altera device. The .pin also provides the following basic information fields for each assigned pin on the device:

- Pin signal name and usage
- Pin number
- Signal direction
- I/O standard
- Voltage
- I/O bank
- User or Fitter-assigned

For more information about using the Quartus II Pin Planner to create or change pin assignment details, refer to the I/O Management chapter in volume 2 of the Quartus II Handbook.

Generating a .pin File

The Quartus II Fitter generates a .pin during a full compilation of your FPGA design, or when performing I/O assignment analysis on your design. You can locate the .pin in your Quartus II project directory with the name <project name>.pin.
For more information about pin and signal assignment transfer and the files that the Quartus II software can import and export, refer to the I/O Management chapter in volume 2 of the Quartus II Handbook.

**FPGA-to-Board Integration with the Cadence Allegro Design Entry HDL Software**

The Cadence Allegro Design Entry HDL software is a schematic capture tool and is part of the Cadence 600 series design flow. Use the Cadence Allegro Design Entry HDL software to create flat circuit schematics for all types of PCB design. The Cadence Allegro Design Entry HDL software can also create hierarchical schematics to facilitate design reuse and team-based design. With the Cadence Allegro Design Entry HDL software, the design flow from FPGA-to-board is one-way, using only the .pin generated by the Quartus II software. You can only make signal and pin assignment changes in the Quartus II software and these changes reflect as updated symbols in a Cadence Allegro Design Entry HDL project. For more information about the design flow with the Cadence Allegro Design Entry HDL software, refer to Figure 8–1 on page 8–3.

Routing or pin assignment changes made in a board layout tool or a Cadence Allegro Design Entry HDL software symbol cannot be back-annotated to the Quartus II software.

For more information about the Cadence Allegro Design Entry HDL software and the Cadence Allegro PCB Librarian Part Developer tool, including licensing, support, usage, training, and product updates, refer to the Help in the software or to the Cadence website (www.cadence.com).

**Creating Symbols**

In addition to circuit simulation, circuit board schematic creation is one of the first tasks required when designing a new PCB. Schematics must understand how the PCB works, and to generate a netlist for a board layout tool for board design and routing. The Cadence Allegro PCB Librarian Part Developer tool allows you to create schematic symbols based on FPGA designs exported from the Quartus II software.

You can create symbols for the Cadence Allegro Design Entry HDL project with the Cadence Allegro PCB Librarian Part Developer tool, which is available in the Cadence Allegro Project Manager tool. Altera recommends using the Cadence Allegro PCB Librarian Part Developer tool to import FPGA designs into the Cadence Allegro Design Entry HDL software.

You must obtain a PCB Librarian Expert license from Cadence to run the Cadence Allegro PCB Librarian Part Developer tool. The Cadence Allegro PCB Librarian Part Developer tool provides a GUI with many options for creating, editing, fracturing, and updating symbols. If you do not use the Cadence Allegro PCB Librarian Part Developer tool, you must create and edit symbols manually in the Symbol Schematic View in the Cadence Allegro Design Entry HDL software.
If you do not have a PCB Librarian Expert license, you can automatically create FPGA symbols using the programmable IC (PIC) design flow found in the Cadence Allegro Project Manager tool. For more information about using the PIC design flow, refer to the Help in the Cadence design tools, or go to the Cadence website (www.cadence.com).

Before creating a symbol from an FPGA design, you must open a Cadence Allegro Design Entry HDL project with the Cadence Allegro Project Manager tool. If you do not have an existing Cadence Allegro Design Entry HDL project, you can create one with the Cadence Allegro Design Entry HDL software. The Cadence Allegro Design Entry HDL project directory with the name `<project name>.cpm` contains your Cadence Allegro Design Entry HDL projects.

While the Cadence Allegro PCB Librarian Part Developer tool refers to symbol fractures as slots, the other tools described in this chapter use different names to refer to symbol fractures. Table 8–2 lists the symbol fracture naming conventions for each of the tools addressed in this chapter.

<table>
<thead>
<tr>
<th>Table 8–2. Symbol Fracture Naming</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cadence Allegro PCB Librarian Part Developer Tool</td>
</tr>
<tr>
<td>During symbol generation</td>
</tr>
<tr>
<td>During symbol schematic instantiation</td>
</tr>
</tbody>
</table>
Cadence Allegro PCB Librarian Part Developer Tool

You can create, fracture, and edit schematic symbols for your designs using the Cadence Allegro PCB Librarian Part Developer tool. Symbols designed in the Cadence Allegro PCB Librarian Part Developer tool can be split or fractured into several functional blocks called slots, allowing multiple smaller part fractures to exist on the same schematic page or across multiple pages. Figure 8-3 shows how the Cadence Allegro PCB Librarian Part Developer tool fits into the design flow.

Figure 8–3. Cadence Allegro PCB Librarian Part Developer Tool in the Design Flow

Notes to Figure 8–3:
(1) For more information about the full design flow flowchart, refer to Figure 8–1 on page 8–3.
(2) Grayed out steps are not part of the FPGA symbol creation or update process.

To run the Cadence Allegro PCB Librarian Part Developer tool, you must open a Cadence Allegro Design Entry HDL project in the Cadence Allegro Project Manager tool. To open the Cadence Allegro PCB Librarian Part Developer tool, on the Flows menu, click Library Management, and then click Part Developer.

Import and Export Wizard

After starting the Cadence Allegro PCB Librarian Part Developer tool, use the Import and Export wizard to import your pin assignments from the Quartus II software.

Altera recommends using your PCB Librarian Expert license file. To point to your PCB Librarian Expert license file, on the File menu, click Change Product and then select the correct product license.

To access the Import and Export wizard, follow these steps:
1. On the File menu, click Import and Export.
2. Select Import ECO-FPGA, and then click Next.
3. In the Select Source page of the Import and Export wizard, specify the following settings:
   a. In the Vendor list, select Altera.
   b. In the PnR Tool list, select quartusII.
   c. In the PR File box, browse to select the .pin in your Quartus II project directory.
   d. Click Simulation Options to select simulation input files.
   e. Click Next.

4. In the Select Destination dialog box, specify the following settings:
   a. Under Select Component, click Generate Custom Component to create a new component in a library,
      or
      Click Use standard component to base your symbol on an existing component.

   Altera recommends creating a new component if you previously created a generic component for an FPGA device. Generic components can cause some problems with your design. When you create a new component, you can place your pin and signal assignments from the Quartus II software on this component and reuse the component as a base when you have a new FPGA design.

   b. In the Library list, select an existing library. You can select from the cells in the selected library. Each cell represents all the symbol versions and part fractures for a particular part. In the Cell list, select the existing cell to use as a base for your part.
   c. In the Destination Library list, select a destination library for the component. Click Next.
   d. Review and edit the assignments you import into the Cadence Allegro PCB Librarian Part Developer tool based on the data in the .pin and then click Finish. The location of each pin is not included in the Preview of Import Data page of the Import and Export wizard, but input pins are on the left side of the created symbol, output pins on the right, power pins on the top, and ground pins on the bottom.

Editing and Fracturing Symbol

After creating your new symbol in the Cadence Allegro PCB Librarian Part Developer tool, you can edit the symbol graphics, fracture the symbol into multiple slots, and add or change package or symbol properties.

The Part Developer Symbol Editor contains many graphical tools to edit the graphics of a particular symbol. To edit the symbol graphics, select the symbol in the cell hierarchy. The Symbol Pins tab appears. You can edit the preview graphic of the symbol in the Symbol Pins tab.
Fracturing a Cadence Allegro PCB Librarian Part Developer package into separate symbol slots is useful for FPGA designs. A single symbol for most FPGA packages might be too large for a single schematic page. Splitting the part into separate slots allows you to organize parts of the symbol by function, creating cleaner circuit schematics. For example, you can create one slot for an I/O symbol, a second slot for a JTAG symbol, and a third slot for a power/ground symbol.

Figure 8–4 shows a part fractured into separate slots.

To fracture a part into separate slots, or to modify the slot locations of pins on parts fractured in the Cadence Allegro PCB Librarian Part Developer tool, follow these steps:
1. Start the Cadence Allegro Design Project Manager.
3. Click Part Developer.
4. Click the name of the package you want to change in the cell hierarchy.
5. Click Functions/Slots. If you are not creating new slots but want to change the slot location of some pins, proceed to Step 6. If you are creating new slots, click Add. A dialog box appears, allowing you to add extra symbol slots. Set the number of extra slots you want to add to the existing symbol, not the total number of desired slots for the part. Click OK.
6. Click Distribute Pins. Specify the slot location for each pin. Use the checkboxes in each column to move pins from one slot to another. Click OK.
7. After distributing the pins, click the Package Pin tab and click Generate Symbol(s).
8. Select whether to create a new symbol or modify an existing symbol in each slot. Click OK.

The newly generated or modified slot symbols appear as separate symbols in the cell hierarchy. Each of these symbols can be edited individually.

The Cadence Allegro PCB Librarian Part Developer tool allows you to remap pin assignments in the Package Pin tab of the main Cadence Allegro PCB Librarian Part Developer window. If signals remap to different pins in the Cadence Allegro PCB Librarian Part Developer tool, the changes reflect only in regenerated symbols for use in your schematics. You cannot transfer pin assignment changes to the Quartus II software from the Cadence Allegro PCB Librarian Part Developer tool, which creates a potential mismatch of the schematic symbols and assignments in the FPGA design. If pin assignment changes are necessary, make the changes in the Quartus II Pin Planner instead of the Cadence Allegro PCB Librarian Part Developer tool, and update the symbol as described in the following sections.

For more information about creating, editing, and organizing component symbols with the Cadence Allegro PCB Librarian Part Developer tool, refer to the Part Developer Help.

**Updating FPGA Symbols**

As the design process continues, you must make logic changes in the Quartus II software, placing signals on different pins after recompiling the design, or use the Quartus II Pin Planner to make changes manually. The board designer can request such changes to improve the board routing and layout. To ensure signals connect to the correct pins on the FPGA, you must carry forward these types of changes to the circuit schematic and board layout tools. Updating the .pin in the Quartus II software facilitates this flow. Figure 8–5 shows this part of the design flow.

**Figure 8–5. Updating the FPGA Symbol in the Design Flow**

![Diagram](Diagram.png)

**Notes to Figure 8–5:**

1. For more information about the full design flow flowchart, refer to Figure 8–1 on page 8–3.
2. Grayed out steps are not part of the FPGA symbol update process.
To update the symbol using the Cadence Allegro PCB Librarian Part Developer tool after updating the .pin, follow these steps:

1. On the File menu, click Import and Export. The Import and Export wizard appears.

2. In the list of actions to perform, select Import ECO - FPGA. Click Next. The Select Source dialog box appears.

3. Select the updated source of the FPGA assignment information. In the Vendor list, select Altera. In the PnR Tool list, select quartusII. In the PR File field, click browse to specify the updated .pin in your Quartus II project directory. Click Next. The Select Destination window appears.

4. Select the source component and a destination cell for the updated symbol. To create a new component based on the updated pin assignment data, select Generate Custom Component. Selecting Generate Custom Component replaces the cell listed under the Specify Library and Cell name header with a new, nonfractured cell. You can preserve these edits by selecting Use standard component and select the existing library and cell. Select the destination library for the component and click Next. The Preview of Import Data dialog box appears.

5. Make any additional changes to your symbol. Click Next. A list of ECO messages appears summarizing the changes made to the cell. To accept the changes and update the cell, click Finish.

6. The main Cadence Allegro PCB Librarian Part Developer window appears. You can edit, fracture, and generate the updated symbols as usual from the main Cadence Allegro PCB Librarian Part Developer window.

If the Cadence Allegro PCB Librarian Part Developer tool is not set up to point to your PCB Librarian Expert license file, an error message appears in red at the bottom of the message text window of the Part Developer when you select the Import and Export command. To point to your PCB Librarian Expert license, on the File menu, click Change Product, and select the correct product license.

### Instantiating the Symbol in the Cadence Allegro Design Entry HDL Software

To instantiate the symbol in your Cadence Allegro Design Entry HDL schematic after saving the new symbol in the Cadence Allegro PCB Librarian Part Developer tool, follow these steps:

1. In the Cadence Allegro Project Manager tool, switch to the board design flow.

2. On the Flows menu, click Board Design.

3. To start the Cadence Allegro Design Entry HDL software, click Design Entry.

4. To add the newly created symbol to your schematic, on the Component menu, click Add. The Add Component dialog box appears.

5. Select the new symbol library location, and select the name of the cell you created from the list of cells.

The symbol attaches to your cursor for placement in the schematic. To fracture the symbol into slots, right-click the symbol and choose Version to select one of the slots for placement in the schematic.
FPGA-to-Board Integration with Cadence Allegro Design Entry CIS Software

The Cadence Allegro Design Entry CIS software is a schematic capture tool (part of the Cadence 200 series design flow based on OrCAD Capture CIS). Use the Cadence Allegro Design Entry CIS software to create flat circuit schematics for all types of PCB design. You can also create hierarchical schematics to facilitate design reuse and team-based design using the Cadence Allegro Design Entry CIS software. With the Cadence Allegro Design Entry CIS software, the design flow from FPGA-to-board is unidirectional using only the .pin generated by the Quartus II software. You can only make signal and pin assignment changes in the Quartus II software. These changes reflect as updated symbols in a Cadence Allegro Design Entry CIS schematic project. Figure 8–2 on page 8–4 shows the design flow with the Cadence Allegro Design Entry CIS software.

Routing or pin assignment changes made in a board layout tool or a Cadence Allegro Design Entry CIS symbol cannot be back-annotated to the Quartus II software.

Creating a Cadence Allegro Design Entry CIS Project

The Cadence Allegro Design Entry CIS software has built-in support for creating schematic symbols using pin assignment information imported from the Quartus II software.

To create a new project in the Cadence Allegro Design Entry CIS software, follow these steps:

1. On the File menu, point to New and click Project. The New Project wizard starts.

   When you create a new project, you can select the PC Board wizard, the Programmable Logic wizard, or a blank schematic.

2. Select the PC Board wizard to create a project where you can select which part libraries to use, or select a blank schematic.

   The Programmable Logic wizard only builds an FPGA logic design in the Cadence Allegro Design Entry CIS software.

Your new project is in the specified location and consists of the following files:

- OrCAD Capture Project File (.opj)
- Schematic Design File (.dsn)
Generating a Part

After you create a new project or open an existing project in the Cadence Allegro Design Entry CIS software, you can generate a new schematic symbol based on your Quartus II FPGA design. You can also update an existing symbol. The Cadence Allegro Design Entry CIS software stores component symbols in OrCAD Library File (.olb). When you place a symbol in a library attached to a project, it is immediately available for instantiation in the project schematic.

You can add symbols to an existing library or you can create a new library specifically for the symbols generated from your FPGA designs. To create a new library, follow these steps:

1. On the File menu, point to New and click Library in the Cadence Allegro Design Entry CIS software to create a default library named library1.olb. This library appears in the Library folder in the Project Manager window of the Cadence Allegro Design Entry CIS software.

2. To specify a desired name and location for the library, right-click the new library and select Save As. Saving the new library creates the library file.

You can now create a new symbol to represent your FPGA design in your schematic. To generate a schematic symbol, follow these steps:

1. Start the Cadence Allegro Design Entry CIS software.

2. On the Tools menu, click Generate Part. The Generate Part dialog box appears (Figure 8–6).

Figure 8–6. Generate Part Dialog Box

3. To specify the .pin from your Quartus II design, in the Netlist/source file type field, click Browse.

4. In the Netlist/source file type list, select Altera Pin File.
5. Type the new part name.

6. Specify the **Destination part library** for the symbol. Failing to select an existing library for the part creates a new library with a default name that matches the name of your Cadence Allegro Design Entry CIS project.

7. To create a new symbol for this design, select **Create new part**. If you updated your .pin in the Quartus II software and want to transfer any assignment changes to an existing symbol, select **Update pins on existing part in library**.

8. Select any other desired options and set **Implementation type** to **<none>**. The symbol is for a primitive library part based only on the .pin and does not require special implementation. Click **OK**.

9. Review the Undo warning and click **Yes** to complete the symbol generation.

   You can locate the generated symbol in the selected library or in a new library found in the **Outputs** folder of the design in the Project Manager window (Figure 8–7). Double-click the name of the new symbol to see its graphical representation and edit it manually using the tools available in the Cadence Allegro Design Entry CIS software.

**Figure 8–7. Project Manager Window**

---

For more information about creating and editing symbols in the Cadence Allegro Design Entry CIS software, refer to the Help in the software.
Splitting a Part

After saving a new symbol in a project library, you can fracture the symbol into multiple parts called sections. Fracturing a part into separate sections is useful for FPGA designs. A single symbol for most FPGA packages might be too large for a single schematic page. Splitting the part into separate sections allows you to organize parts of the symbol by function, creating cleaner circuit schematics. For example, you can create one slot for an I/O symbol, a second slot for a JTAG symbol, and a third slot for a power/ground symbol. Figure 8–8 shows a part fractured into separate sections.

Figure 8–8. Splitting a Symbol into Multiple Sections  (Notes 1), (2)

Notes to Figure 8–8:
(1) Figure 8–8 represents a Cyclone device with JTAG or passive serial (PS) mode configuration option settings. Symbols created for other devices or other configuration modes might have different sets of configuration pins, but can be fractured in a similar manner.
(2) The power/ground section shows only a representation of power and ground pins because the device contains a high number of power and ground pins.

Although symbol generation in the Design Entry CIS software refers to symbol fractures as sections, the other tools described in this chapter use different names to refer to symbol fractures.
To split a part into sections, select the part in its library in the Project Manager window of the Cadence Allegro Design Entry CIS software. On the Tools menu, click Split Part or right-click the part and choose Split Part. The Split Part Section Input Spreadsheet appears (Figure 8–9).

**Figure 8–9. Split Part Section Input Spreadsheet**

Each row in the spreadsheet represents a pin in the symbol. The **Section** column indicates the section of the symbol to which each pin is assigned. You can locate all pins in a new symbol in section 1. You can change the values in the **Section** column to assign pins to various sections of the symbol. You can also specify the side of a section on the location of the pin by changing the values in the **Location** column. When you are ready, click **Split**. A new symbol appears in the same library as the original with the name `<original part name>_Split1`.

View and edit each section individually. To view the new sections of the part, double-click the part. The Part Symbol Editor window appears and the first section of the part displays for editing. On the View menu, click Package to view thumbnails of all the part sections. To edit the section of the symbol, double-click the thumbnail.

For more information about splitting parts into sections and editing symbol sections in the Cadence Allegro Design Entry CIS software, refer to the Help in the software.
Instantiating a Symbol in a Design Entry CIS Schematic

After saving a new symbol in a library in your Cadence Allegro Design Entry CIS project, you can instantiate the new symbol on a page in your schematic. Open a schematic page in the Project Manager window of the Cadence Allegro Design Entry CIS software. To add the newly created symbol to your schematic on the schematic page, on the Place menu, click Part. The Place Part dialog box appears (Figure 8–10).

Figure 8–10. Place Part Dialog Box

Select the new symbol library location and the newly created part name. If you select a part that is split into sections, you can select the section to place from the Part pop-up menu. Click OK. The symbol attaches to your cursor for placement in the schematic. To place the symbol, click on the schematic page.

For more information about using the Cadence Allegro Design Entry CIS software, refer to the Help in the software.

Altera Libraries for the Cadence Allegro Design Entry CIS Software

Altera provides downloadable .olb for many of its device packages. You can add these libraries to your Cadence Allegro Design Entry CIS project and update the symbols with the pin assignments contained in the .pin generated by the Quartus II software. You can use the downloaded library symbols as a base for creating custom schematic symbols with your pin assignments that you can edit or fracture. This method increases productivity by reducing the amount of time it takes to create and edit a new symbol.

To use the Altera-provided libraries with your Cadence Allegro Design Entry CIS project, follow these steps:

1. Download the library of your target device from the Download Center page found through the Support page on the Altera website (www.altera.com).
2. Create a copy of the appropriate .olb to maintain the original symbols. Place the copy in a convenient location, such as your Cadence Allegro Design Entry CIS project directory.

3. In the Project Manager window of the Cadence Allegro Design Entry CIS software, click once on the Library folder to select it. On the Edit menu, click Project or right-click the Library folder and choose Add File to select the copy of the downloaded .olb and add it to your project. You can locate the new library in the list of part libraries for your project.

4. On the Tools menu, click Generate Part. The Generate Part dialog box appears (Figure 8–11).

Figure 8–11. Generate Part Dialog Box

5. In the Netlist/source file field, click Browse to specify the .pin in your Quartus II design.

6. From the Netlist/source file type list, select Altera Pin File.

7. For Part name, type the name of the target device the same as it appears in the downloaded library file. For example, if you are using a device from the CYCLONE06.OLB library, type the part name to match one of the devices in this library such as ep1c6f256. You can rename the symbol in the Project Manager window after updating the part.

8. Set the Destination part library to the copy of the downloaded library you added to the project.

9. Select Update pins on existing part in library. Click OK.

10. Click Yes.
The symbol is updated with your pin assignments. Double-click the symbol in the Project Manager window to view and edit the symbol. On the View menu, click **Package** if you want to view and edit other sections of the symbol. If the symbol in the downloaded library is fractured into sections, you can edit each section but you cannot further fracture the part. You can generate a new part without using the downloaded part library if you require additional sections.

For more information about creating, editing, and fracturing symbols in the Cadence Allegro Design Entry CIS software, refer to the Help in the software.

**Conclusion**

Transferring a complex, high-pin-count FPGA design to a PCB for prototyping or manufacturing is a daunting process and can lead to errors in the PCB netlist or design, especially when different engineers are working on different parts of the project. The design workflow available when the Quartus II software is used with tools from Cadence assists the FPGA designer and the board designer in preventing such errors and focusing all attention on the design.

**Document Revision History**

Table 8–3 shows the revision history for this chapter.

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 2012</td>
<td>12.0.0</td>
<td>Removed survey link.</td>
</tr>
<tr>
<td>November 2011</td>
<td>10.0.2</td>
<td>Template update.</td>
</tr>
<tr>
<td>December 2010</td>
<td>10.0.1</td>
<td>Template update.</td>
</tr>
<tr>
<td>July 2010</td>
<td>10.0.0</td>
<td>General style editing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Removed Referenced Document Section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added a link to Help in “Performing Simultaneous Switching Noise (SSN) Analysis of Your FPGA” on page 9–5.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>General style editing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edited Figure 9–4 on page 9–10 and Figure 9–8 on page 9–16.</td>
</tr>
<tr>
<td>March 2009</td>
<td>9.0.0</td>
<td>Chapter 9 was previously Chapter 7 in the 8.1 software release.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No change to content.</td>
</tr>
<tr>
<td>November 2008</td>
<td>8.1.0</td>
<td>Changed to 8-1/2 x 11 page size.</td>
</tr>
<tr>
<td>May 2008</td>
<td>8.0.0</td>
<td>Updated references.</td>
</tr>
</tbody>
</table>

For previous versions of the Quartus II Handbook, refer to the [Quartus II Handbook Archive](#).